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Chapter 1. Release Notes
Contains information about new features, defect fixes, and known issues in Unica
Campaign and Optimize that HCL releases as part of a scheduled software release.

Unica Campaign 12.1 system requirements and
compatibility
Unica Campaign is part of the Unica suite of products. Unica Campaign version 12.1
requires Unica Platform 12.1.

Where to find complete system requirement and compatibility information
For a list of Unica product versions compatible with this product and a list of third-party
requirements for this product, see the Recommended Software Environments and Minimum
System Requirements document. ).
You can also access this document by selecting Help > Product documentation when you
are logged in to Unica.

Prerequisites for using Unica Campaign
Before you begin using Unica Campaign, confirm that your environment meets the following
requirements.
• For an improved user experience, use at least a 21" screen.
• For an improved user experience, set your screen resolution to 1600 x 900. Lower
resolutions can result in some information not being properly displayed. If you use a
lower resolution, maximize the browser window to see more content.
• A mouse is best for navigating in the user interface.
• Do not use the browser controls to navigate. For example, avoid using the Back and
Forward buttons. Instead, use the controls that are in the user interface.
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• If pop-up blocker (ad blocker) software is installed on the client machine, Unica
Campaign might not function properly. For best results, disable pop-up blocker
software while running Unica Campaign.
• Ensure that the technical environment meets the minimum system requirements and
the supported platforms.*
• The correct browser and versions must be used.*
• Clear the browser cache after upgrading or applying any fix pack. This only needs to be
done once, after the application is updated.
• If you use Internet Explorer (IE) with Unica Campaign or any module that uses Unica
Campaign flowcharts (Unica Deliver, Unica Optimize, Unica Interact, Unica Collaborate):
To log in multiple times to view side-by-side information, open IE and log in to Unica.
Then select File > New Session in the IE menu bar. In the new IE browser window, log in
to Unica as the same or a different user.
Important: Do not use any other method to open multiple sessions. For example,
do not open a new tab; do not open another browser session from the Start menu or
desktop icon; and do not use File > New Window in IE. These methods can corrupt
information that is shown in the application.
*For details on the items indicated by an asterisk, see the Unica Recommended Software
Environments and Minimum System Requirements.

Unica Campaign documentation roadmap
Unica Campaign provides documentation and help for users, administrators, and
developers.
Table 1. Get up and running
Task
Find out about new features, known
issues, and limitations

Documentation
Unica Campaign Release Notes
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Task

Documentation

Learn about the structure of the

Unica Campaign System Tables and Data

Unica Campaign system tables

Dictionary

Install or upgrade Unica Campaign

One of the following guides:
• Unica Campaign Installation Guide
• Unica Campaign Upgrade Guide

Unica Insights Reports for Unica

Unica Insights Installation and Configuration Guide

Campaign
Implement the IBM Cognos® reports

Unica Reports Installation and Configuration Guide

provided with Unica Campaign
Table 2. Configure and use Unica Campaign
Task

Documentation

• Adjust configuration and security Unica Campaign Administrator's Guide
settings
• Prepare Unica Campaign for
users
• Run utilities and perform
maintenance
• Learn about integrations
• Create and deploy marketing

Unica Campaign User's Guide

campaigns
• Analyze campaign results
Improve flowchart performance

Unica Campaign Tuning Guide

Use Unica Campaign functions

Macros for HCL Unica
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Table 3. Integrate Unica Campaign with other HCL products
Task
Integrate with IBM Engage

Documentation
Campaign and Engage Integration Guide for IBM
Marketing Cloud

Integrate with IBM Digital Analytics

Unica Campaign Administrator's Guide: How to
configure the integration
Unica Campaign User's Guide: Targeting IBM
Digital Analytics segments in campaigns

Integrate with Unica Plan

Unica Plan and Unica Campaign Integration Guide

Integrate with Opportunity Detect

Unica Campaign Administrator's Guide: How to
configure the integration
Opportunity Detect Administrator's Guide
and Opportunity Detect User's Guide: How to
administer and use the product

Integrate with Unica Deliver

Unica Campaign Installation and Upgrade guides:
How to install and prepare Deliver components in
the local environment.
Unica Deliver Startup and Administrator's Guide:
How to connect to the hosted messaging
resources.
Unica Campaign Administrator's Guide: How to
configure offer integration.

Integrate with IBM SPSS Modeler

Unica Campaign and IBM SPSS Modeler

Advantage Enterprise Marketing

Advantage Enterprise Marketing Management

Management Edition

Edition Integration Guide

Integrate with IBM WeatherFX.

You can integrate WeatherFX with Campaign
so that you can pull weather events into your
marketing campaigns. Unica Campaign version 9
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Task

Documentation
and version 10 users can integrate with WeatherFX
by using the UBX toolkit.

Integrate with Unica Director.

Unica Director Installation Guide: You can
integrate Unica Director with Campaign so that
you can get status of all the running/completed/
failed flowcharts, migrate Camapigns from one
Unica Campaign environment to other, download/
delete flowchart logs etc.

Integrate with Journey

Unica Campaign can integrate with Journey so
that a continuous communication with users
can be established based on the inputs from
Campaign.
Refer Campaign Administrators guide > Unica
Campaign and Unica Journeys integration

Integrate with Link

Unica Campaign uses Link capabilities of
connectors which include the configuration and
provisioning to connect to any delivery channel.
Refer Campaign Administrators guide > Unica
Campaign and Unica Link integration

Note: Additional integrations may be available that are not listed in this table. See
Product tools and utilities for Unica Campaign.
Table 4. Develop for Unica Campaign
Task
Use the REST API
Use the SOAP API

Documentation
See the Unica Campaign REST API
• See the Unica Campaign SOAP API
Specification

Campaign Release Notes | 1 - Release Notes | 6

Task

Documentation
• JavaDocs in devkits
\CampaignServicesAPI

Develop Java™ plug-ins or command-

• See the Unica Campaign Validation PDK Guide

line executables to add validation to

• Java-docs in devkits\validation

Unica Campaign
Table 5. Get help
Task
Open online help

Instructions
When using the Unica Campaign application:
1. Choose Help > Help for this page to open a
context-sensitive help topic.
2. Click the Show navigation icon in the help
window to display the full help.
You must have web access to view contextsensitive online help. Contact Support for
more information about accessing and
installing Knowledge Center locally for offline
documentation.

Get PDFs

When using the Unica Campaign application:
• Choose Help > Product documentation to
access Unica Campaign PDFs.
• Choose Help > All Unica documentation to
access all product PDFs.
• Click the links for PDFs during the installation
process.
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New features and changes in Campaign
Unica Campaign 12.1.0.3 includes a number of new features and changes. These are listed
underneath.
For a list of newly supported and discontinued platforms, see the Recommended Software
Environments and Minimum System Requirements guide.
You can find the documentation here.
• PDFs: http://doc.unica.com/products/index.php?
showFolder=RW50ZXJwcmlzZQ==&folder=Y2FtcGFpZ24vMTJfMV8w
• Online Help: https://help.hcltechsw.com/unica/Campaign/en/12.1.0/index.html

New platforms
• Campaign version 12.1.0.3 supports HCL OneDB as system database. For more
information about installing Unica version 12.1.0.3 with system tables on HCL OneDB,
see the Unica V12.1.0.3 Installation Guide for OneDB.
• Campaign version 12.1.0.3 supports WAS 8.5.5 FP18.

Custom reports are supported in Unica Insights
Custom reports for Campaign are suuported in Unica Insights.

Insights reports are available in different languages
Unica Insights reports for Campaign are available in different languages.

Campaign and Campaign flowcharts details can be accessed from Journey
Entry sources
Campaign and Campaign flowchart details will be available journey Entry sources.
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New Link connectors Facebook and Linkedin are available now.
Unica Link connectors including Facebook and Linkedin are available. See the Unica Link
documentation for more details.

Upgraded MVC framework from Struts 1.3.8 to Spring 5.1.18 to fix Security
vulnerability
The MVC framework is upgraded from Struts 1.3.8 to Spring 5.1.18 to fix Security
vulnerability (in Struts 1.3.8) as per the current industry standards.

Fixed defects in Campaign
The following defects were fixed in Unica Campaign 12.1.0.3.

Issue key

Summary

HMA-319059 When customer passed Database details in Run command, flowchart run
failed with RUN error 703: File read error when invoking flowchart from
unica_svradm.
HMA-319041 UA_CCRUNLOG table displayed incorrect status when Flowchart ran in
branch mode issue.
HMA-319039 For different flowchart Runs RUN_DATE was added in Inconsistent Date
Format in maillist Process box.
HMA-319037 Clustered listeners allowed same flowchart to be executed at same time on
different listeners servers.
HMA-319033 When customer tried to export data with Cloudera database and Impala
driver to a mapped Cloudera table and did not map all the fields in the
snapshot process, the shanpshot process failed with error.
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HMA-318940 An error occurred while using Unica 11.1.0.x when users tried to import
a CSV file (created in Excel, but saved as a valid CSV) into a Target Cell
Spreadsheet (TCS) while using MacOS and Safari browser.
HMA-318396 Push templates were not visible in the dropdown after upgrading to version
11.1.0.3.
HMA-314604 Pagination on the Advance Search result listing page was not working.
Application showed the same page after the next page was clicked.
HMA-302398 In Select Process box when condition was created manually the Number of
records in Select Process box execution were incorrect.
HMA-316587 Unable to redirect on object page from Campaign reports in Cognos-11,
having object hyperlinks.

Known issues in Campaign
Unica Campaign 12.1.0.3 includes the following known issues.
Table 6.
ID
322046

Known issues
Localization is broken since version 12.0 and not working as expected.
VERSION : Campaign.mo file invalid on RHEL : Localization not working.

321395

Incorrect unica_aclsnr, unica_acsvr and other utilities version after
upgrade to 12.1.0.3 on RHEL.

320648

If user did overlay installation the ".go" navigation URL changes reverted
to ".do" for navigation URLs at 'Affinium|suite|uiNavigation|mainMenu|
Campaign'.

310343

Campaign flowcharts with old eMessage process box will not work in
V12.1.
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ID
312109

Known issues
Campaign upgrade installation from 12.0 to 12.1 completed with three
non-fatal errors.

300159

HTTP Communication error occurs, while saving flowchart if Unica
Platform and Campaign applications are using the same JNDI.
It is suggested to use separate JNDIs for Platform and Campaign
applications.

295574

Deployment of Campaign application in wWebSphere application
server failed due to java.lang.NoClassDefFoundError:
javax.el.ELManager. Users are required to copy
javax.el-3.0.1b11.jar in the Websphere application servers lib

directory. They can download javax.el-3.0.1-b11.jar from https://
mvnrepository.com/artifact/org.glassfish/javax.el/3.0.1-b11.
311916

Journey Process box: Searching in Journey PB retains its last search
string. User need to manually clear the search criteria.

306110, 306108 While deploying or starting Campaign application, it throws errors
related to module-info.class, and warning related to obsolete hibernate
namespace. These can be ignored.
304803

Getting "jcc][t4][10217][10310][4.14.111] Connection read-only mode is
not enforceable after the connection has been established." warnings in
WebSphere console log. No impact on application side. These can be
ignored.

306095

Production documentation links on Campaign installer are broken. See
the documentation available along with product installers.

312150

Journey Process box: Search in Associated Journyes with multiple
words is not working.

310126

eMessage instances in Campaign uninstall folder – these can be
ignored. Unica no longer support eMessage.
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ID
312299

Known issues
Campaign or Platform navigation url when contains default http or https
port then recent menu’s does not work. If you are using default http (80)
or https (443) ports in navigation url please remove them.

312231

Campaign swagger APIs will not work only on swagger page when
marketing platform login method is set to Web Access control.

303532

With MariaDB as system database Optimize, Maillist or Calllist process
box execution fail with error 10646. You must enable In DB Optimization
in flowchart advance settings to resolve this error.

13460

When the Export to File option is unchecked on the Fulfillment tab of
the Mail List process, the Summary File option is enabled but should
not be.

175825

When defaultBehaviorWhenOutputToFile is set to Create New File, it
works only when you select a new output (export) file for the first time.
If you try to change the existing output file and select a new output file,
then the option Append to Existing Data gets selected by default.
It can be changed manually to Create New File.

APAR 198495,

For a custom macro, if a user account has assigned as Not Granted

PO05293,

permission for a stored object (Custom Macros, Flowchart Templates,

198494

Stored Derived Fields, etc.), the custom macro can be used to edit,
delete, add, move all stored objects regardless of permissions.

204347

LARGE_DATA: Browser Crash - Mail List process box with 700 segments
- Save with 512 offers to each segment.

211253

File-based input with multiple columns containing date in different
format does not read the date correctly.

212890

Boolean type column on Amazon Redshift is recognized as 'Test' field
type in table mapping.
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ID
220474

Known issues
When the column name of the source table contains Non-ASCII
characters and is long (probably longer than 10 x 3bytes characters in
UTF8), the Snapshot process does not run because the temp table is
not created.

220705

Profiling count for Dimension table fields is incorrect and profiling
percentage is displayed as 100% even if profiling is in progress.

APAR 222047,

Unica Campaign extract process does not write to DB2 database when

PO06172,

flowchart is configured with two extract processes and the second

222049

extract process contains a derived field that uses French accented
characters in the name of the derived field.

APAR 225568,

temptablepostexecutionsql is not run when selecting coremetrics

PO06304,

segment.

225572
230340

Inconsistent behavior for the Mail list process is observed when the
data filter is assigned to Effective date on the Parameters tab in a new
Mail list process when compared to an edited existing Mail list process.
The Mail list process does not output a datetime derived field in the
output log file. Changing the effective date parameter values might
cause execution failure of the Mail list.

230606

In a flowchart where fields are extracted and used in a Mail list process,
the fields under Extract Node on the Personalization tab of the Mail list
process are different before and after running the process.

231859

While using the Chrome browser, it takes around 20 seconds to respond
while loading the Personalization tab of the Mail list process if it
contains large number of treatments and offers assigned. For example,
a Mail list process with 250 cells, each cells with multiple offers, each
offer having multiple attributes.
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ID
232502

Known issues
A Mail list performance issue occurs when the user changes the input
in any way and there is a delay when initially switching tabs. After the
user changes the input and switches to the Treatment or Process tab
for the first time, there is a delay of around 10-15 seconds depending on
the number of inputs selected. After this initial delay, there is no delay
until the input is changed.

232835

The Campaign application performance is affected and sometimes an
exception error message is displayed on the Campaign pages when
the application is used for a longer time (some days) with continuous
usage. You must restart your Campaign web application and Campaign
Listeners

238789

While using the Chrome browser, when a user opens a Mail list with 600
cells having multiple offers assigned to each cell, the application stops
responding. While using the Internet Explorer 11 browser, nothing is
displayed in the Mail list process box.

239142

When the Audience process fails because of an incorrect Count
filter expression, and the user removes the filter expression, adds a
Condition, and runs the Audience process again, the process fails.
The Condition is not considered and instead the previous Count filter
expression is used resulting in the failure. To run the Audience process
successfully, you must re-open the Audience process configuration
window, click the Condition, Save and Close. The Audience process now
considers the Condition and runs successfully.

APAR 243895,
PO06966,
243897

A space character is converted to '' while profiling.
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ID

Known issues

PMR 223848,

Irrelevant flowcharts turned up in a Campaign when different users

245664

access different flowcharts at the same time, the wrong flowchart
seems to be displayed.

248007

Hive Performance: PRE -Single Insert statements executed for loading
data in temp tables (extract) when used with Hive takes 19 minutes for
2000 records.

PMR 269280,

Truncate does not function for the DB2 database. The

269765

DeleteAsTruncate property specifies whether, when an output process

is configured to REPLACE TABLE, Campaign uses TRUNCATE TABLE
or deletes from the table. When the value is TRUE, Campaign runs a
TRUNCATE TABLE from the table. When the value is FALSE, Campaign

runs a DELETE FROM from the table. The default value depends on the
database type, with a large number of clients moving from Oracle
to DB2 the difference in performance is extremely noticeable. The
comparison in performance in Snapshots and Mail lists for customers
leaving Oracle to DB2 is drastic.
269785

For the Chrome and Safari browsers, when the locale is set as
Japanese, the labels overlap the buttons in the Save template window.

270528

Use and Profile buttons remains enabled for the Select process when
the user selects some table fields and then applies the search filter in
the Select process such that it does not return any matching table.

270814

Users cannot select values from the On a trigger drop down by using
the mouse on the Scheduler page.

271642

A "Please wait....." message is displayed multiple times in console
mode installation while upgrading from version 10.1 and also for new
Installation

271676

The Extract table on the DB2 and Oracle databases is not deleted when
In-DB optimization is unchecked.
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ID
272253

Known issues
The Campaign application performance is affected when a user opens
the Table mapping window and more than 500 tables are mapped.

2968

Hot keys are not implemented on most of the windows. In the Dojo
implementation it is not possible to use keyboard shortcuts to activate
certain functions. Instead the user must click buttons.

PMR 266519,

Clicking Return to previous page distorts the user interface in some

75262

cases. Use the links within the products to navigate, rather than the
browser controls.

N/A

When Unica Campaign is deployed in an application server cluster
environment with 80 port, the Campaign navigation URL should not
contain this port number. For example: http://<host>.<domain>:80/
Campaign should be changed to http://<host>.<domain>/
Campaign. Change the value of the serverURL property under Campaign|

navigation on the Settings > Configuration page.
N/A

Mail List process box gets unconfigured with error "31606: History
table are changed" on Flowchart run.

1. There is no issue if the history tables are mapped prior to building a
flowchart and adding a Mail List process.
2. If you do not follow step 1, you can still map the history tables
after the error appears. If you edit the flowchart and configure the
process box, the process will run.
N/A

After migrating non-ASCII data to Campaign, in some cases you cannot
open Campaign flowcharts on the target system. Session flowcharts
open successfully. To work around this issue, remigrate the campaigns
in overwrite mode. You can then open the flowcharts.

TT 062333

Information related to associated products does not appear in offer
on Marketing Operations. When an offer created in Campaign with
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ID

Known issues
products associated with it is imported in Marketing Operations,
information about the associated products is not available in Marketing
Operations.

270655

Table Mapping : Table name containing @ is supported while mapping
a table, special characters like @ are should not be supported in Table
names. Since Table name containing @ is supported since some time,
this functioning is not updated now.

283637

When user has one maillist PB configured in the flowchart and he
adds another maillist PB in the same flowchart, it is observed that All
the values from already configured in treatment tab, Parameters tab,
Personalisation tab of new Maillist PB appear automatically in any new
dragged maillist PB.

281389

While running Campaign in the Upgrade mode, the installer should read
the installation properties files from the previous version response
files as we had that response available at the install location from
the previous installation. However, it does not read the installation
properties files from the earlier version response files.

280623

In Sample PB if we specify '3' in "# of Samples/Output Cells" field and
Configure [sample1] with 3 samples having sample sizes as 50%, 50%
and "All remaining records" respectively based on "Random Sample
method" then after running Flowchart if we reopen the Sample PB
"Process run results will be lost. Continue?" message is displayed in
sample PB when remaining All check boxed is check.

283101

CHROME: "Unable to notify roles/permission changes to Campaign,
Deliver OD may be out of sync". On clicking save changes for the
Security Policy displays the following pop-up, this happens just first
time after user logs in and changes anything in the policy and clicks
save changes. Also, this is reproducible just on CHROME. Tested on
Chrome V64 and V65.
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ID
282844

Known issues
Campaign Offer doesn’t sort on 'Channel' & 'Eff./Exp.Dates'. After
clicking on every column the offers below it should be sorted in
ascending order. If you click on the same column the second time, the
offers beneath it should be sorted in the descending order.

283695

Segment process box execution failed with extract enabled to User
database for the IMPALA user DB. This error does not reproduce when
extracting to Unica Campaign server.

284436

Platform.war and campaign.war in ear file deployment will not work in
Weblogic 12.2.1, work around is to deploy campaign.war and unica.war
separately

288228

If the date field uploaded to IMC side is not in mm/dd/yyyy format, the
email process box fails to execute. This data format is required by IMC
Importlist API. It works accurately if DELIM_M_D_YYYY(mm/dd/yyyy)
format is used for date while uploading to IMC using importlist API.

289135

TOMCAT : Occasionally Unica Platform or Campaign does not gets
started after deploying in tomcat application server. Workaround :
delete Campaign and Platform directory available inside Tomcat
webapps directory and delete the content of work directory from the
path where Tomcat is installed.

304945

Refresh command does not refresh the master listener priority or
weight, if you need to make changes in priority or weight you require to
take a downtime and restart the application.

312445

Link Process box - sending data only for the first input cell selected to
link.

UL-285

Connection Salesforce - Subsequent Salesforce actions are failing for
Update (Lead/Contact) intermittently.
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ID
UL-250

Known issues
Connection Mandrill - Intermittenly stop sending emails to targeted
audiences.

UL-281

Connection Mandrill - Subject line with non english characters - mandrill
not sending email to user.

UL-259/UL-242

Connection Mailchimp/Mandril - results would be available for 1000
users only.

UL-214

MailChimp/Mandril - Audience value is getting changed to id field after
selection or reopening process box.

UL-194

MailChimp/Mandril - In Mandrill template if merging field added as
localized character - personalization is not working.

UL-257

Link Connections page takes time to load in the Campaign process box.

UL-231

Twilio Connection - Only 5 fields are supported for personalization in
SMS body/text area.

UL-279

Connection MailChimp - Branch run or single link process box run is not
supported with Link process box with Mailchimp connection. You will
need to execute complete flowchart.

UL-287

Link process box fails when no output data.

NA

Unica Campaign and Unica Link applications urls should be having
same domain names. Unica Campaign and Link applications deployed
on different domains will not work.

UL-189

Connection Mandrill/MailChimp- Emojis are not working in Mandrill and
MailChimp connector Mail Subject line.

313650

Platform Scheduled flowcharts are not getting executed
afterupgrade.Use the quartzjobtool to update scheduler jobs. This is
a requiredstep. If this upgrade tool is not run, any existing scheduled
job willfail to start. The quartzjobtool is in the tools\bin directory
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ID

Known issues
underUnica Platform installation. Run this utility from the tools
\bindirectory.Example command (Windows): quartzjobtool.batExample
command (Unix): ./quartzjobtool.sh

306383

UBX registration utility is failing with error Caused by:
java.lang.ClassNotFoundException: org.jboss.logging.BasicLogger error

316802

12.1 FP2 MariaDB]:CODE 704: File write error. while extracting extracted
fields and table fields to database server through Segment PB

Known issues in Optimize V12.1
Issue
Scores entered manually in the score

Issue ID
Defect 194109

Description
Scores entered manually

matrix are not considered while

should be considered for

optimizing the contact list.

calculation in the Customer
Capacity rule. However,
while applying the Customer
Capacity rule, scores in the
PCT are considered, and
all customer records are
removed in the optimized
list.

Campaign Optimize summary report is
incorrect.

Defect 176368

If offer versions are used
in a rule, the report that
shows pre-optimization
versus post-optimization
counts will always report
the pre-optimization count
of records as 1. The post-
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Issue

Issue ID

Description
optimization counts will be
correct.

After upgrading Campaign to 9.1,

Defect 81245

Users must upgrade Unica

Optimize listener can no longer be

Campaign and Unica

stopped via ACOServer.sh.

Optimize together. If they
cannot, they will need to
stop the Unica Optimize
listener manually through
the task manager/kill
command.

Error messages for the ACOOptAdmin

DEF051284

When you run the

utility do not display according to non-

ACOOptAdmin command

English locales.

line utility in a locale other
than English, error messages
do not display according
to the specified locale. The
error messages display only
in English.

unprocessables_sessionid.csv

DEF054841

In some scenarios, a

might contain some customers who

few of the customers

receive offers.

who get offers might
be present in the
unprocessables_sessionid.csv
file.

Incorrect optimization result with

DEF058362

A customer that satisfies

Custom Capacity rule in specific

the following criteria might

circumstances.

receive fewer offers than
wanted:
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Issue

Issue ID

Description
• The customer has
an even number of
proposed transactions.
• Each of these
transactions has the
same score.
• This score is a low
value.

Some labels display incorrectly in

DEF059595

Japanese, Chinese, and Korean.

Some translated labels are
displaying incorrectly. For
example, when you edit the
score matrix manually, the
vertical label on the right
side of the table displays
upside down. Also, for
optimization rules that
contain customers in the
segment, the segment label
displays on two lines.

Offer filtering summary report displays DEF059805

The Offer Summary Report

an incorrect count of Proposed

displays incorrect counts in

Contacts that are removed by each

the "Removed By This Rule"

Custom Capacity rule.

column for Custom Capacity
rules if the participating
Flowchart for this Unica
Optimize session contains
multiple contact dates and
multiple offers that are
made to each customer on
different channels.
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Issue
Issues with offer version query builder.

Issue ID
DEF060676

Description
There are several minor
issues with the offer version
query builder:
• For custom attributes
with the Form Element
Type of Select Box,
the offer version query
builder does not use
the select box. You
must enter the value
manually.
• When the group level is
removed, the subgroup
conditions are added
to the parent condition,
and vice versa.
• All arithmetic operators
are displayed for a
string variable, but only
equal and not equal
apply.
• Defined length
validations for attributes
are not verified upon
input for conditions.

Offer version rules that contain dates

DEF061554

If you create an offer version

do not provide expected optimization

condition that includes

results.

a date, such as the offer
parameter "valid end date"
equals "12/31/2011", the
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Issue

Issue ID

Description
rule containing offer version
condition might not be
satisfied; however, the rest
of the rules will work as
expected.

Rule exceptions that span calendar

DEF061639

years give incorrect results.

If you create a rule exception
to a Min/Max # Offers
capacity rule that spans
calendar years, such as
07/01/2011 to 06/30/2012,
the rule containing rule
exception condition will not
be satisfied; however, the
rest of the rules will work as
expected.

<unica_svradm> refresh command

HMA-304945

does not reflect the change.

On a running environment,
after changing the
master listener priority,
<unica_svradm> refresh
command does not reflect
the change.

<unica_svradm> refresh command
does not delete the node from cluster.

HMA-305764

If you delete a listener
node from existing cluster,
<unica_svradm> refresh
command does not delete
the node from cluster.
Execution requests are
still observed going to the
deleted node. Restarting the
listener solves this issue.
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Issue

Issue ID

Description
Will be fixed in upcoming
fixpack.

Users are still able to manually

HMA-306037

When flowchart execution

interfere in the running flowchart when

is in progress through

flowchart execution is in progress

SVRADMIN utility or using

through SVRADMIN utility.

scheduler, user is still able
to manually interfere in the
running flowchart. Will be
fixed in upcoming fixpack.

Known limitations in Unica Campaign V12.1
Unica Campaign 12.1 includes the following known limitations.
Table 7. Unica Campaign known limitations
ID
304128

Known limitation
Platform login method or users authentication from third party directory
services is not supported with Campaign or Optimize APIs. Users
require to use the Unica Platform user to use with APIs.

305130

The flowchart template is not imported, if it contains data source name
more than 256 character length. Save the flowchart template again by
changing the datasource name with less than 256 chars.

305764

For any reason, if users delete the Campaign listener node configuration
from listener cluster configuration in Unica Platform, while the
application is up and running then users connected to this listener node
are not redirected to another listener. You must restart the Campaign
web application. If you require to delete the listener node, take a
downtime and restart Campaign web and listener components.
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ID
17202

Known limitation
Error 19024: Cannot delete segment folder if the segment was deleted
from the folder. A segment that is deleted from a folder remains as an
inactive segment in the folder. Folders with inactive segments cannot
be deleted. This is working as intended.

185854

Big data: Campaign integration with Hadoop-based Hive big data as a
user data source is not tested on MS Windows operating system.

190621

Big data: Campaign with Hive big data as a user database does not
support user table mapping with Base and Dimension levels up to the
fourth level hierarchy. If you map a Base record table with four levels of
dimension tables in a Select process box, then build a query based on
the fourth level Dimension table, the query fails with Error 11528. This
issue should not affect big data users because multiple dimensions
should not be needed. By definition, a big data source has a large table
of records split across Hadoop nodes (such as HDFS).

194095

For Redshift database, the error message "Unsupported type
timestamps with time zone" is displayed when exporting data from a
Snapshot process box. Timestamp with timezone is an unsupported
PostgreSQL data type on Amazon AWS.

195581

While running a Campaign flowchart, if listener crashes or is stopped,
user is not able to access the running flowchart from the UI. Requests
are being served by another node of the cluster but while accessing the
flowchart, a pop-up message says "listener failover occurred..." It may
be necessary to restart the master listener.

232032

User can start only one Campaign listener on one server (machine) in
case of Listener clustering.

PMR 243195,

When a column that has the Greek Letters A and B is profiled in

244148

Campaign, the system returns only A along with the count of all the
records. After the fix, some of the non-English characters, which differ
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ID

Known limitation
only in case (like é and É in French), are counted as two different values
in profiling. English language characters are not counted as case
sensitive.

244482

Deep search lists all the Campaigns that are created through Marketing
Operations projects when Campaign - Marketing Operations integration
is on. Campaigns that are created through Marketing Operations
projects when Marketing Operations - Campaign integration is enabled)
are not listed on Campaign list page and are only available on the
Marketing Operations project listing page. Users who do not have
the permission to access Marketing Operations are able to access
campaigns which are created through Marketing Operations projects
through Deep search results.

248943

If the user profile database is changed (change in the table column
values of audience record) for fields other than sync fields and the
user runs the Email process again, a negative count is returned for the
DUPLICATES parameter from Engage in the Campaign flowchart log.

N/A

Big data: To perform the UPDATE operation on any process boxes in a
flowchart, ensure that your HIVE tables are configured as transactional
tables such that they support the ACID property. This is a key feature
introduced in HIVE version 0.14.

N/A

Interact when configured with IBM WebSphere Application Server:
You must configure IBM WebSphere JVM to use JDK 1.7. When IBM
WebSphere Application Server 8.5.5.x is configured with JDK 1.7 and
HTTPS communication, you must use IBM JAVA SDK version 7.0.8.10
or higher.

N/A

Using multiple SQL statements for raw SQL queries is not currently
supported on big data user datasources. For related information, search
the IBM Knowledge Center for Hive query language conformance.
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ID
N/A

Known limitation
Dialog behavior: In certain cases, it is necessary to click twice in order
to activate a field or change a field value.

N/A

The monitorEnabledForDeliver configuration property in Campaign|
monitoring is not currently used.

N/A

Relevant products limitation: When offer management is performed
from Unica Plan, the "relevant products" functionality, which relates
product IDs to offers, is not available.

N/A

Blank or incorrect results from derived fields in a Mail List process.
This can occur in a process box that uses a derived field that calls a
Generated field (UCGF) that changes value.
Do not use a UCGF in a Mail List derived field if the UCGF is not
constant. Also, from the Parameters tab, do not create a derived field to
call a UCGF to populate offer attributes.

N/A

Profiling a Campaign Generated Field (UCGF) does not yield correct
results. Some UCGFs have a value according to the cell or the offer
being processed. For cell-related UCGFs, only the value associated with
the first cell appears during profiling.

N/A

The default value for a custom cell attribute does not appear when
you open the target cell spreadsheet. Although the default value is not
initially displayed, it will be used. The value can be displayed or changed
by clicking or opening and editing the custom cell attribute in the target
cell spreadsheet.

N/A

The UA_UsrResponseType.Name field cannot contain a left parenthesis
followed by a single quote.

N/A

Use unique TempTablePrefix for each data source when mapping
multiple data sources to same physical database.
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ID

Known limitation
If you mapped multiple data sources in Unica Campaign to the same
physical database, and you use the same TempTablePrefix for more
than one of the data sources, when you use the cleanup utility to delete
orphaned temp tables, it may falsely identify temp tables as orphaned,
when they are in fact legitimate temp tables defined from a different
Unica Campaign data source.
Any deleted temp tables will automatically be recreated when you
rerun affected flowcharts, but as a best practice, use a unique
TempTablePrefix for each data source when mapping multiple data

sources to the same physical database.
If the data sources defined in Unica Campaign map to different
schemas in the database, another solution is to ensure that the
database user who runs the cleanup utility does not have privileges to
drop tables in other schemas in the same database.
161323

The error "Login failed. Error 10553" can occur if you try to log in to the
Campaign utilities when the Unica Platform | Security | login method
is set to Windows integrated login or Web access control. To avoid
this issue, change the login type to LDAP or Platform prior to using the
Campaign utilities..

176377

DB2 10.5 BLU for user DB: No indexing requirement for temp tables
in Unica Campaign datasource. DB2 10.5 (with BLU feature ON) does
not require indexing in Unica Campaign. Unica Campaign has certain
properties for datasources, such as TempTablePreTruncateRunScript,
TempTablePostExecutionSQL, and PostTempTableCreateRunScript,
where you can provide SQL or scripts to create indexes on user
database tables. If you are using DB2 10.5 as a customer database,
with the BLU feature ON, you do not need to configure any of these
temp table properties.
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ID

Known limitation

201,968,200,241 If two process boxes are moved very close together in a flowchart,
the direction of the connection arrow changes. This limitation affects
the visual representation of the arrow. The process data flow is not
affected. The workaround is to move the process boxes farther apart so
the arrowhead changes back to the correct direction.
211293

In Unica Campaign, the built-in macro Current_Date() results in an error
when executed against a Hive 1.2 based Big Data instance. The Hive
ODBC driver does not support the Current_Date macro to obtain interval
values. For example, executing the following query results in a Hive
error:
SELECT DISTINCT customerid FROM Customer_date WHERE
((Customer_date.my_date_mmdyyyy - CURRENT_DATE()) >= 7)
Error: Hive 2 Internal error: unsupported conversion from type:
interval_day_time
Workaround: To use the Current_Date function in a RAW SQL query on
Hive with Hortonworks, execute SQL in the following format:
SELECT DISTINCT customerid FROM Customer_date WHERE
(current_date() - my_date_mmddyyyy ) = interval '0 0:0:0' day to second

310769

In Unica Campaign, the built-in macro Current_Date() results in an
error when executed against Impala data source. The Impala ODBC
driver does not support the Current_Date macro to obtain interval
values. For example, executing the following query results in an error:
INSERT INTO TABLE UAC_133824_5 SELECT DISTINCT store_id,
d_customer_key FROM srvacammo.bast_segment WHERE
(srvacammo.bast_segment.ba_last_trans_date > (CURRENT_DATE - 2))
Error: Error while executing a query in Impala: [HY000] :
AnalysisException: Could not resolve column/field reference:
'current_date'
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ID

Known limitation
Workaround: In raw SQL query, the Current_Date would not work
with Impala, so instead of current_date, users can use now() or
current_timestamp().

213088

If Campaign is installed in a secured environment but IBM Cognos is in
an unsecured environment, Cognos reports will not display when you
use Microsoft Internet Explorer 11. Workaround: If Unica Campaign is
configured with HTTPS, also configure IBM Cognos on HTTPS.

217488

IBM can support the Database Loader for Redshift until the moment
Campaign triggers the Loader Script. Any problems in execution of the
loader script are not supported by IBM.

223716

Authentication Bypass Using HTTP Verb Tampering
Instead of applying theHttpVerbFilter.class patch, you can use the
following workaround to ensure application security.
Complete the following steps to update web.xml.
1. Update the web app tag and set the xsd version to 3.0.
<web-app xmlns:xsi="http://www.w3.org/2001/XMLSchemainstance"
xmlns="http://java.sun.com/xml/ns/javaee"
xsi:schemaLocation="http://java.sun.com/xml/ns/
javaee
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd"
id="Platform" version="3.0" metadatacomplete="true">

2. Add the following in web.xml.
<!--[start] WhiteList Http Verbs -->
<security-constraint>
<web-resource-collection>
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ID

Known limitation
<web-resource-name>Unica_WhiteList_Http_Verbs</webresource-name>
<url-pattern>/*</url-pattern>
<http-method-omission>GET</http-method-omission>
<http-method-omission>POST</http-method-omission>
<http-method-omission>TRACE</http-method-omission>
<http-method-omission>PUT</http-method-omission>
<http-method-omission>DELETE</http-method-omission>
<http-method-omission>PATCH</http-method-omission>
<http-method-omission>OPTIONS</http-method-omission>
<http-method-omission>HEAD</http-method-omission>
</web-resource-collection>
<auth-constraint/>
</security-constraint>
<!--[end] WhiteList Http Verbs -->

283805

IBM Websphere Application Server 8.5.5 Fix Pack 12 requires IFPI85892
to run HCL Unica application.

283544

On Oracle 12.2 database server following parameters needs to be
added in sqlnet.ora file located under ORACLE_HOME/network/admin/
SQLNET.ALLOWED_LOGON_VERSION_SERVER
User will need to consult with DBA to provide appropriate value to this
parameter. Please refer this link for details: https://docs.oracle.com/
database/121/NETRF/sqlnet.htm#NETRF2016

N/A

Campaign Integration with Watson Marketing Assistant is not
supported on Internet Explorer.

286705

Two events get generated on the Campaign history tab when user
pauses the Campaign flowchart from Operational monitoring.
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ID
287100

Known limitation
History tab data remains in UA_History table even after deleting the
Campaign

290172

Cutting off right contents from Relevant offers window.
Workaround: The size of text, apps and other items - under Display
should be set to 100%.

312318

Campaign flowchart run - when executed as complete flowchart
generates a unique runID and its executed the flowchart along with
mailchimp process box.
Next time when Campaign user tries to run the single process box - it
does not generate unique runID and thus process box execution failed.

312296

HTTPS(Invalid certificate) HIP instance is not supported in IE11 for Link
PB and Manage Link Connections page.

312320

MailChimp - Audience value is getting changed to other format
f239295fe8 (in alphanumeric format) if we re-open correctly configured
Link PB. The workaround is to hit the Fetch button adjacent to the field
which will refresh the value of the user-friendly string value.

312567

Campaign installer failed to update Insights report files when installed
using non-root user on Unix environment. To overcome this user
would need to update Insights report file manually after installation is
completed.
1. Navigate to <PLATFORM_HOME>/Insights/tools/bin/
2. For UNIX:
• Grant read, write, and execute permissions to -bPath=<Report
folder path> for the installation user.

• Grant execute permission to the installation user using the
following command.
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ID

Known limitation
chmod 755 insightsDBUtil.sh

3. Execute command to update the Campaign Insights report files.
./insightsDBUtil.sh -ds=CampaignDS -bPath=<Report folder path> DBType=<databasetype> -URL=JDBC connection URL> -user=<database
user> -pwd=<database password>
For more details refer UnicaInsights12_1InstallationConfigurationGuide
313216

Link: Unica application on HTTPS and unica Link on HTTP does not
render the Manage links connections page.

Known limitations in Unica Optimize V12.1
Issue

Number

Description

Strings in the production or

Defect

In the case of a non-English setup, the

test pop-up window are not

176920

strings in the production or test pop-up

translated.

window are not translated.

The MailList process fails

Defect

Change the value of UseTempTablePool

with the following database

170951

from TRUE to FALSE in UA_SYSTEM_TABLES.

error: ORA-00999: INVALID

The MailList run will end successfully.

VIEW NAME.

Unica Optimize does not

Defect

In case of a schedule run of a Unica

terminate the unica_acsvr

164875

Optimize session by using the Unica

process that is opened

Platform Scheduler, you observe multiple

during a run.

unica_acsvr login processes. These

processes might terminate automatically
after some time.
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Issue

Number

Description

A DB2 database user change Defect

To avoid having a session fail, the DB2

of system tables causes a

database administrator should remove

155876

Unica Optimize session to

indexes.

fail when the administrator
has an index with the same
name.
In a Unica Optimize report,

Defect

The following issues were noticed while

offers by type and segment

102889

printing the offers by type and segment in a

do not get printed as

Unica Optimize report.

desired.
1. The preview window does not scroll,
unless it is resized.
2. While printing it does not print
everything, but only what fits in A4 size.
Printing options do not seem to make
any difference.
Negative scores cause

DEF041400

inaccurate rules crediting.

If you use negative scores, rule crediting in
the Offer Filtering Summary report might
not be accurate.
Offers with negative scores are given to
meet minimum requirements only.

Cells that are linked to TCS

DEF061355

If the Optimize process is connected to

with offer assignments

one or more cells and the upstream cells

do not appear in Optimize

are later linked to top-down cells defined in

process.

the Target Cell Spreadsheet process (TCS),
the offers that are assigned in the TCS do
not automatically appear in the Optimize
process. Link to any top-down cells in the
TCS before you connect those cells to an
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Issue

Number

Description
Optimize process. Otherwise, you must
either manually assign the same offers
within the Optimize process, or delete the
Optimize process and re-create it.

Running the ACOOptAdmin

DEF046832

You cannot use the ACOOptAdmin utility

utility with one-way SSL

with one-way SSL until you register a

requires more setup.

security certificate, specify a host name and
domain, and configure SSL_Options in the
ACOOptAdmin.bat file.

Unable to run the session

DEF055010

If you use the kill command to stop

in first attempt when

unica_acosvr, the next time you attempt

unica_acosvr process

to run a Unica Optimize session, it might

stopped.

fail with the following error: An unknown
communication failure has occurred
with the

Optimize server process.

Workaround - Run the Unica Optimize
session again to complete it successfully.
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